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1. Наименование методики измерений 

 

Настоящий документ СТП-14.621.21.0008.01-2014устанавливает 

методику «Методика оценки определения состояния аутофагосомно-

лизосомной системы модельных животных по каждому из следующих 

маркеров: LC3II, ATG12»  

 

2. Назначение методики измерений и область применения 

 

Настоящая методика описывает процедуру анализа состояния 

аутофагосомно-лизосомной системы модельных животных по каждому из 

следующих маркеров аутофагии: LC3II, ATG12.  

Основными областями применения данной методики являются 

нейронауки (оценка состояния аутофагосомно-лизосомной системы 

модельных животных, определения содержания компонентов систем 

клеточной защиты в образцах нервной ткани животных, разработка новых 

терапевтических средств).  

 

3. Нормативные ссылки 

 

В настоящей методике использованы нормативные ссылки на 

следующие стандарты и документы: 

ГОСТ Р 8.563-2009 Государственная система обеспечения единства 

измерений. Методики (методы) измерений 

СТП – 1.42.02 – 2002 Стандарты предприятия. Общие требования к 

построению, изложению, оформлению, содержанию, обозначению и порядку 

введения 
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ГОСТ 1.5—2001 Межгосударственная система стандартизации. 

Стандарты межгосударственные, правила и рекомендации по 

межгосударственной стандартизации. Общие требования к построению, 

изложению, оформлению, содержанию и обозначению  

ГОСТ Р ИСО 9000—2008 Системы менеджмента качества. Основные 

положения и словарь. 

 

4. Погрешность измерений 

Не устанавливаются. 

 

5. Требования к показателям точности измерений 

Получение изображения осуществляется на системе детекции 

хемилюминесценции и флуоресценции BioSpectrum AC Chemi HR410 (UVP), 

оснащенной охлаждаемой CCD камерой и персональным компьютером. 

 

6. Условия измерений 

Диапазон температуры окружающей среды для проведения измерений – 

18-27ºС.  

Диапазон сохранения адекватной силы хемилюминесцентного сигнала 

для детекции – до 10 мин 

7. Требования к средствам измерений, вспомогательным 

устройствам, материалам, реактивам, применяемым для оценки 

определения состояния аутофагосомно-лизосомной системы 

 

7.1.Реактивы 

- Пентобарбитал натрия (Euthatal, США) 

- Высокосолевой буфер (50 мМТрисHClpH 7,5, 750 мМNaCl, 5 мМ 

ЭДТА) 
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- Ингибиторы протеаз MiniProtean, Roche, США 

- буфер RIPA (50 мМТрисHClpH 7,4, 150 мМNaCl, 1% NP40, 0,25% 

дезоксихолат натрия, 1мМ фенилметилсульфонилфторид) 

- Тритон-X100 

-Буфер Лэммли для нанесения проб (100 мMТрисHClpH 6,8, 20% 

глицерина, 4% ДСН, 0,2% бромфенолового синего, 200 мМ 2-β-

меркаптоэтанола) 

-Раствор для приготовления полиакриламидных гелей 

акриламида/бисакриламида (из 30%-ного готового раствора, Sigma, США), 

300 мMTrisHClpH 8,8, 0,1% персульфата аммония, 0,1% ДСН, 0,01% 

тетраметилэтилендиамина; концентрирующий гель – 6% 

акриламида/бисакриламида, 300 мMТрисHClpH 6,8, 0,1% персульфата 

аммония, 0,1% ДСН) 

-10% раствор тетраметилэтилендиамина 

-Трис-Твин буфер (50 мMТрисHClpH 7,4, 150 мМNaCl, 0,1% Твин-20) 

-раствор 4%-ного обезжиренного молока 

 

7.2. Материалы 

Антитела первичные:  

поликлональные кроличьи против LC3-II и ATG12 (DAKO, США, разведение 

1:500), 

Антителавторичные:  

- против IgG кролика, конъюгированные с пероксидазой хрена (Amersham, 

Великобритания).  

 

Прочее  

- Толстостенные пробирки Special Beckman Eppendorf (BeckmanCoulter, 

США)  

- Реагенты ECL Plus (Amersham, Великобритания)  
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- поливинилденфторидная мембрана (Hybond, Великобритания).  

 

7.3. Оборудование 

Основное средство измерений – система детекции хемилюминесценции 

и флуоресценции BioSpectrum AC Chemi HR410 (UVP) и программное 

обеспечение к ней; программное обеспечение Image J. 

Вспомогательные устройства (устройства, необходимые для 

подготовки образцов для проведения измерений): 

-Термоциклер Eppendorf Mastercycler Personal 

-Системы для белкового гель-электрофореза в ПААГ (Bio-Rad, 

Великобритания) и иммуноблоттинга (Amersham, Великобритания): камера 

Bio-Rad Mini-Protean® 3 Cell и источник питания PowerPacBasic, Bio-Rad, 

США, аппарат для переноса (Amersham, Великобритания) 

- Центрифуга Eppendorf 5415 (Eppendorf, Германия) 

- Центрифуга Eppendorf 5417R, охлаждаемая модель (Eppendorf, 

Германия) 

- Шейкер-инкубатор MR-1 (Biosan, Латвия) 

- Ручной гомогенизатор (TechWare, Sigma, США) 

- УльтрацентрифугаOPTIMA MAX-XP (Beckman Coulter, США) 

-StepOne Real-Time PCR System (Applied Biosystems) 

8. Операции при выполнении методики определения состояния 

аутофагосомно-лизосомной системы модельных животных по каждому 

из следующих маркеров: LC3II, ATG12 

8.1. Последовательная экстракция белков 

В день проведения экстракции белков добавляют ВСБ непосредственно 

к замороженным тканям головного или спинного мозга. Для получения 

тотального белка ткани гомогенизируют в ВСБ с ингибиторами протеаз и 

центрифугируют в течение 20 мин при 15 000 об/мин при 4°C, отбирают 
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осветленный супернатант и немедленно замораживают при -80°С для 

последующей детекции. 

Для фракционирования к тканям добавляют холодный высокосолевой 

буфер (ВСБ; 50 мМТрисHClpH 7,5, 750 мМNaCl, 5 мМ ЭДТА), содержащий 

ингибиторы протеаз (MiniProtean, Roche, США; 1 таблетка на 10 мл буфера) в 

соотношении 1:10 (мас:об) и немедленно гомогенизируют с помощью 

ручного гомогенизатора (TechWare, Sigma, США). 

Для получения осветленного постмитохондриального супернатанта 

получившийся гомогенат центрифугируют при 13 000 об/мин, 4°С в течение 

20 мин. Полученный супернатант переносят в толстостенные пробирки 

Special Beckman Eppendorf и центрифугируют при 48 000 об/мин в течение 20 

мин при 4°С, ультрацентрифуга OPTIMA MAX-XP (BeckmanCoulter, США). 

Полученный супернатант соответствует растворимой фракции 

(водорастворимые белки). Нерастворимый осадок промывают ВСБ, 

ресуспендируют в ВСБ с добавлением Тритон X-100 (1%) и снова 

центрифугируют при 48 000 об/мин в течение 20 мин при 4°С. Полученный 

супернатант соответствует Тритон X-100-растворимой (Tр.Х-100, детергент-

растворимой) фракции. Нерастворимый в ВСБ-ТX-100 осадок промывают 

этим же буфером и ресуспендируют в буфере RIPA (50 мМТрисHClpH 7,4, 

150 мМNaCl, 1% NP40, 0,25% дезоксихолат натрия, 1мМ 

фенилметилсульфонилфторид) и снова центрифугируют при 48 000 об/мин в 

течение 20 мин при 4°С. Полученный супернатант соответствует RIPA-

растворимой фракции. Нерастворимый в буфере RIPA осадок лизируют в 

двукратном буфере Леммли для денатурирующего электрофореза, 

содержащем додецилсульфат натрия (детергент-нерастворимая фракция). 

8.2. Денатурирующий гель-электрофорез по Леммли 

Перед нанесением на гель к анализируемым образцам добавляют 

равный объем двукратного буфера Лэммли для нанесения проб (100 

мMТрисHClpH 6,8, 20% глицерина, 4% ДСН, 0,2% бромфенолового синего, 
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200 мМ 2-β-меркаптоэтанола), кипят в течение 5 мин и немедленно 

помещают в ледяную баню. При нанесении образцов на дорожки по 

сравнению с фракцией растворимых белков количество Tритон X-100- и 

RIPA-фракций для каждой конструкции увеличивают в два раза, детергент-

нерастворимой фракции – в 1,5 раза. Разделяющий гель содержит 10 или 16% 

(в зависимости от молекулярной массы белка) акриламида/бисакриламида (из 

30%-ногоготового раствора, Sigma, США), 300 мMTrisHClpH 8,8, 0,1% 

персульфата аммония, 0,1% ДСН, 0,01% тетраметилэтилендиамина; 

концентрирующий гель – 6% акриламида/бисакриламида, 300 мMТрисHClpH 

6,8, 0,1% персульфата аммония, 0,1% ДСН, 0,01% 

тетраметилэтилендиамина). Для электрофореза используют буфер, 

содержащий 25 мMТрисHCl, 192 мM глицина, 0,1% ДСН. Электрофорез 

проводили в течение 50 мин при постоянном напряжении 200 В и 

переменной силе тока (камера Bio-Rad Mini-Protean® 3 Cell и источник 

питания PowerPacBasic, Bio-Rad, США). 

8.3. Иммуноблоттинг 

После разделения в геле белки переносят на поливинилиденфторидную 

мембрану Hybond-P (Amersham, Великобритания) методом полусухого 

электроблоттинга. Мембрану перед переносом инкубируют сначала в 100% 

метаноле, промывают водой MilliQ и оставляют в буфере для переноса (25 

мМТрис, 0,15 мM глицина, 20% метанола) при покачивании на 5-10 мин. 

Отдельно инкубируют в этом же буфере полученный гель. Помещают гель с 

плотно прижатой мембраной между двумя листами бумаги Wathman 3 ММ, 

смоченной в буфере для переноса, в аппарат для полусухого блоттинга 

(TechWare, Sigma, США) и переносятбелки на мембрану в течение 90 мин 

при токе 50 мА на 50 см2. 

После электроблоттинга промывают мембрану в Трис-Твин буфере 

(ТТБ; 50 мMТрисHClpH 7,4, 150 мМNaCl, 0,1% Твин-20) 3 раза по 5 мин. 

Блокируют мембрану в 4% растворе обезжиренного сухого молока в ТТБ 1 
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час при комнатной температуре, затем инкубируют с первичными 

антителами (указаны выше) в том же растворе при 4°C в течение ночи. После 

инкубации с первичными антителами промывают мембрану в ТТБ 3 раза по 5 

мин, и инкубируют с вторичными антителами (против IgG мыши или IgG 

кролика, конъюгированными с пероксидазой хрена; Amersham, 

Великобритания; 1:3000) 1,5 ч при комнатной температуре. После инкубации 

мембрану отмывают в ТТБ 3 раза по 5 мин. Детекцию специфического 

связывания антител проводят с помощью реагентов ECL Plus (Amersham, 

Великобритания) согласно инструкции производителя. 

Полученная мембрана после детекции используется для дальнейшего 

измерения. 

8.4. Получение изображения для измерения 
 

Получение изображения осуществляется на системе детекции 

хемилюминесценции и флуоресценции BioSpectrum AC Chemi HR410 (UVP), 

оснащенной охлаждаемойCCD камерой и персональным компьютером 

(Рисунок 1). 

 
Рисунок 1 –  Комплектность BioSpectrum AC Chemi HR410 (UVP). 
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Включить систему и запустить программное обеспечение Vision Works 

Software. Подождать, пока система завершит инициализацию и перейдет в 

рабочее состояние (5 мин). Если система не завершила загрузку всех 

необходимых инструментов в течение указанного времени, не переходить к 

дальнейшим действиям. Постараться устранить неполадки системы и 

повторить инициализацию с использованием Инструкции по эксплуатации, 

либо обратиться за квалифицированной помощью. 

После инициализации системы смешать равные объемы растворов ECL (в 

общем случае 0,5 мл каждого реагента на мембрану площадью 50 см2) и 

поместить смесь на лицевую поверхность мембраны. Немедленно поместить 

образец мембраны с перенесенными опытными образцами и 

соответствующими контрольными образцами (негативный контроль – 

образец, в котором компонент системы клеточной защиты отсутствует и 

позитивный контроль – в котором присутствует известное количество 

компонента системы клеточной защиты) на жесткую подложку, 

установленную в среднем положении во внутренней камере прибора. 

Закрыть дверцу прибора. 

Выбрав вкладку Analysis на верхней панели, перейти во вкладку Acquisition. 

C использованием вкладки Lightning and Filters (Рисунок 6) на панели слева 

установить последовательно 

Filter – Clear 

EpiIllumination - Off 

Transillumination – Off 

C использованием вкладки Preview на панели справа выбрать режим Preview. 

Используя вкладку Lens Controls на панели слева и контролируя качество 

изображения в окне Preview, установить необходимые значения апертуры, 

зумирования и фокусировки, чтобы при активации режима. 
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Сделать снимок изображения (команда Aquire на панели справа). Оценить 

качество изображения и, при необходимости, повторить процедуру 

получения изображения. 

Вынуть мембрану из камеры и поместить в трис-твин буфер для дальнейшего 

использования. 

Изображение сохранить в формате TIFF для последующей обработки и 

измерения с использованием программного продукта Image J. 

 

8.5. Процедура измерения 
 

Открыть файл для измерения в программе Image J. 

Следовать пути: Analyze>Gels>Gel Analyzer Options ->вкладка Label With 

Percentages, Outline Lanes and Invert Peaks 

Выбрать инструмент Rectangular Selection. нарисовать прямоугольник вокруг 

измеряемого образца (полосы). При этом захватывать пространство вокруг 

полосы, как показано на Рисунке 2. 

 
Рисунок 2- Выделение первой дорожки. 

Следовать пути: to Analyze>Gels>Select First Lane. В появившемся окне с 

копией изображения и первой полосой, обведенной линией, использовать 

клавиши со стрелками на клавиатуре и, нажимая каждый раз номер 

соответствующей полосы (1, 2, 3.. ), промаркировать остальные полосы 

(Рисунок 3). В случае негативного контроля выделить область, в которой 

должна быть полоса. 



СТП-14.621.21.0008.01-2014 

 12

 
Рисунок 3 – Выделение последующих дорожек. 

Следовать пути: Analyze>Gels>PlotLanes. В новом окне появится график 

профиля для каждой дорожки. 

Выбрать инструмент StraightLineSelection. у основания каждого пика 

провести линию от одной стороны пика до другой, в результате чего пик 

будет помещен в ограниченную область. Для визуализации остальных линий 

навести курсор и, нажав левой кнопкой мыши на пустой области каждого 

профиля, поместить поверх. 

Выбрать нажатием Wand (Wandtracingtool) на второй панели сверху. 

С помощью выбранного инструмента выбрать нажатием левой кнопки мыши 

область внутри пика для каждой дорожки. 

Следовать пути: Analyze>Gels>LabelPeaks. Открыть окно Results выбрать на 

верхней панели окна Edit>CopyAllи перенести данные файл MSExcel. 

Дать файлу MS Excel соответствующее название и получившиеся значения 

для образцов внести в базу данных как первичные значения. 

 

8.6. OT-ПЦР в реальном времени 

Для выделения тотальной РНК из тканей спинного и головного мозга 

мышей используется набор RNeasyPlus (Qiagen). 1 мкг тотальной РНК 

используется для синтеза комплементарной ДНК цепи с помощью обратной 

транскриптазы SuperScript® III (Invitrogen) и гексамерного рандом-праймера 

(Promega) согласно протоколу SuperScript® III. ПЦР в реальном времени 

проводят с полученной кДНК в качестве матрицы в амплификаторе StepOne 

Real-Time PCR System (Applied Biosystems) с использованием набора 
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DyNAmo HS SYBR Greensupermix (Finnzymes). В качестве внутреннего 

контроля используется уровень экспрессии гена GAPDH мыши. 

Все контрольные образцы проверяются в 2% агарозном геле. Превышение 

над внутренним контролем L13a рассчитывается по методу 2-ΔΔCT. 

Характеристика используемых праймеров: 

ATG12 F 

CCCCGTCTTCCGCTGCAGTT 

ATG12 R 

TCGTGTTCGCTCTACTGCCCACT 

В качестве внутреннего контроля используется уровень экспрессии гена 

рибосомного белка человека L13a, который амплифицируют с помощью 

пары праймеров: 

5’-GCATCCCACCGCCCTACGAC-3’ 

5’-CCAGCCAACCTCGTGAGCCA-3’. 

Все использованные праймеры конструируются с помощью программы 

primer3TM. Условия реакции: 95оC 30 сек, 60 оC 30 сек, и 72оC 30 сек, 35 

циклов. 

 

9.Обработка и оформление результатов измерений 

 

Обработка результатов измерений должна осуществляться по 

следующему алгоритму: 

1. Произвести вычитание значения, полученного для образца – 

негативного контроля, из всех других значений. 

2. Определить содержание компонента путем сравнения значения, 

полученного для экспериментального образца, со значением для образца 

положительного контроля. 
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3. Получившееся значение выразить в абсолютных единицах и внести в 

базу данных как промежуточное значение. 

4. Для результатов трех независимых измерений на одном образце, 

отличающихся друг от друга не более чем на 15%, определить среднее 

арифметическое. Полученное значение внести в базу данных как 

окончательное значение для данного образца. 

Результаты измерений оформляются в виде таблиц, с использованием 

табличного редактора MS Excel. В общем случае таблица имеет следующие 

графы: 

ID/шифр/код 

образца  

Даты 

выполнения 

измерений  

Промежуточны

е значения  

Примечания  ФИО и 

подпись 

исполнителя  

     

 

10. Требования безопасности, охраны окружающей среды 

 

Помещение должно соответствовать требованиям пожаробезопасности 

по ГОСТ 12.1.004 и иметь средства пожаротушения по ГОСТ 12.4.009. 

Содержание вредных веществ в воздухе не должно превышать норм 

установленных ГН 2.2.5.1313-03 «Предельно допустимые концентрации 

(ПДК) вредных веществ в воздухе рабочей зоны». Организация обучения 

работников безопасности труда – по ГОСТ 12.0.004. 

При выполнении измерений необходимо соблюдать требования, 

изложенные в технической документации к приборам. 
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11. Требования к квалификации операторов 

 

К выполнению измерений могут быть допущены штатные сотрудники, 

имеющие соответствующую профессиональную подготовку, прошедшие 

соответствующий инструктаж, освоившие метод в процессе тренировки. 
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Валидация методики оценки определения состояния аутофагосомно-

лизосомной системы модельных животных по каждому из следующих 

маркеров: LC3II, ATG12 

 

Наиболее распространенными маркерами активации аутофагосомно-

протеасомной системы являются соотношение форм белка LC3 (I и II) и 

содержание маркера аутофагии ATG12. 

Для исследования отдаленного эффекта хронического введения 

димебона на активность аутофагосомной системы в тканях пораженных 

отделов нервной системы модельных мышей линии tauP301S была проведена 

оценка количественного соотношения между изоформами белка LC3. 

Известно, что при повышении активности аутофагии баланс между LC3-I и 

LC3-II сдвигается в сторону изоформы LC3-II. Данные количественного 

иммуноблоттинга не выявили изменений в соотношении LC3-изоформ в 

препаратах тотального белка спинного мозга tauP301S-мышей в возрасте 5 и 

6 месяцев (Рисунок 4), что говорит о том, что на поздних стадиях тау-патии 

нейропротекторный эффект димебона не может быть объяснен лишь 

активацией аутофагосомной системы. 
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Рисунок 4 – Соотношение LC3-I и LC3-II изоформ в препаратах 

тотального белка из тканей спинного или головного мозга трансгенных 

мышей на развитых стадиях тау-патии и Aβ-амилоидоза соответственно. 

Линия tauP301S, приведены данные для 5-ти и 6-ти месячных животных 

получавших (+) и не получавших (-) димебон. На панели справа 

представлены репрезентативные фотографии иммуноблоттинга. 

 

Исследование эффекта димебона на уровень транскрипции генов, 

кодирующих белки – компоненты аутофагосом, Atg5, Atg10 и Atg16, а также 

уровень экспрессии белка IRGM (связанная с иммунитетом ГТФаза 

семейства М), принимающего непосредственное участие в регуляции 

аутофагии (Рисунок 5). Данные количественной ПЦР показали активацию 

экспрессии на уровне мРНК для всех составляющих комплекса: для Atg5 и 

Atg12 регистрировался кратковременный, но сглаженный рост экспресии с 

пиком примерно через 2-3 часа добавления Димебона, в то время как 

максимальная экспрессия Atg16 была зарегистрирована через 1 час  

добавления димебона. Наблюдаемый синхронный рост в уровнях 

транскрипции Atg5, Atg12 и Atg16 может являться указанием того, что 

обработка клеток SH-SY5Y димебоном приводит к запуску программы 

активации аутофагосомно-лизосомной системы. 
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Рисунок 5 – Изменение уровня экспресии генов ATG5, ATG12, ATG16 

и IRGM, вовлеченных в функционирование аутофагосомно-лизосомной 

системы. 




